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About This Document

This document explains how to install, configure, and deploy the BEA WebLogic
Adapter for PeopleSoft 8 for WebLogic Integration 7.0, which is used to develop
online connections to PeopleSoft 8 applications.

This document is organized as follows:

Chapter 1, “Installing the Adapter for WebLogic Integration 7.0,” directs users to
the information they need before installing the BEA WebLogic Adapter for
PeopleSoft 8 and describes how to install the adapter.

Chapter 2, “Installing and Compiling the Component Interfaces,” describes how
to install and compile the component interfaces.

Chapter 3, “Installing and Configuring the BEA TCP/IP Message
Router,”describes how to install and configure the BEA TCP/IP Handler to
enable PeopleSoft 8 event functionality.

Audience

This document is written for system integrators who develop client interfaces between
PeopleSoft 8 and other applications. It describes how to install and deploy the BEA
WebLogic Adapter for PeopleSoft 8 and how to use it with WebLogic Integration and
adapter tools to develop online connections to PeopleSoft applications. It is assumed
that readers know Web technologies and have a general understanding of Microsoft
Windows and UNIX systems as well as:

General knowledge of the PeopleSoft environment, including Application
Designer and PeopleTools.
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General knowledge of PeopleSoft Application Messaging and PeopleSoft
Component Interface.

Business application knowledge in some specific application area.

Knowledge of PeopleSoft 8 processes and data model for the required
application area.

General knowledge of WebLogic Integration architecture.

General knowledge of client-server concepts.

Related Information

The BEA corporate Web site (www.bea.com) provides all documentation for
WebLogic Server and WebLogic Integration. For information about these products, go
to http://e-docs.bea.com. Documents that you may find helpful when installing
the BEA WebLogic Adapter for PeopleSoft 8 are:

BEA WebLogic Adapter for PeopleSoft 8 User Guide

BEA Application Explorer Installation Guide

BEA WebLogic Platform 7.0 installation and user documentation, which is
available at the following URL:

http://edocs.bea.com/platform/docs70/index.html

PeopleSoft 8 Documentation, available online or on CD-ROM. The following
components are applicable:

PeopleSoft Component Interface

PeopleSoft Internet Architecture Administration

PeopleSoft Application Messaging
vi BEA WebLogic Adapter for PeopleSoft 8 Installation and Configuration Guide



Contact Us!

Your feedback on the BEA WebLogic Adapter for PeopleSoft 8 documentation is
important to us. Send us e-mail at docsupport@bea.com if you have questions or
comments. Your comments will be reviewed directly by the BEA professionals who
create and update the BEA WebLogic Adapter for PeopleSoft 8 documentation.

In your e-mail message, please indicate which version of the BEA WebLogic Adapter
for PeopleSoft 8 documentation you are using.

If you have any questions about this version of BEA WebLogic Adapter for PeopleSoft
8, or if you have problems installing and running BEA WebLogic Adapter for
PeopleSoft 8, contact BEA Customer Support through BEA WebSupport at
www.bea.com. You can also contact Customer Support by using the contact
information provided on the Customer Support Card, which is included in the product
package.

When contacting Customer Support, be prepared to provide the following information:

Your name, e-mail address, phone number, and fax number

Your company name and company address

Your machine type and authorization codes

The name and version of the product you are using

A description of the problem and the content of pertinent error messages

Documentation Conventions

The following documentation conventions are used throughout this document.

Convention Item

boldface text Indicates terms defined in the glossary.
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Ctrl+Tab Indicates that you must press two or more keys simultaneously.

italics Indicates emphasis or book titles.

monospace
text

Indicates code samples, commands and their options, data structures and
their members, data types, directories, and file names and their extensions.
Monospace text also indicates text that you must enter from the keyboard.

Examples:

#include <iostream.h> void main ( ) the pointer psz

chmod u+w *

\tux\data\ap

.doc

tux.doc

BITMAP

float

monospace
boldface
text

Identifies significant words in code.

Example:

void commit ( )

monospace
italic
text

Identifies variables in code.

Example:

String expr

UPPERCASE
TEXT

Indicates device names, environment variables, and logical operators.

Examples:

LPT1

SIGNON

OR

{ } Indicates a set of choices in a syntax line. The braces themselves should
never be typed.

[ ] Indicates optional items in a syntax line. The brackets themselves should
never be typed.

Example:

buildobjclient [-v] [-o name ] [-f file-list]...
[-l file-list]...

Convention Item
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| Separates mutually exclusive choices in a syntax line. The symbol itself
should never be typed.

... Indicates one of the following in a command line:

That an argument can be repeated several times in a command line

That the statement omits additional optional arguments

That you can enter additional parameters, values, or other information

The ellipsis itself should never be typed.

Example:

buildobjclient [-v] [-o name ] [-f file-list]...
[-l file-list]...

.

.

.

Indicates the omission of items from a code example or from a syntax line.
The vertical ellipsis itself should never be typed.

Convention Item
BEA WebLogic Adapter for PeopleSoft 8 Installation and Configuration Guide ix
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CHAPTER
1 Installing the Adapter 
for WebLogic 
Integration 7.0 

This section provides instructions for installing the BEA WebLogic Adapter for
PeopleSoft 8 with WebLogic Integration. It includes the following topics:

Before Installing the Adapter

Understanding the Representation of Paths

Step 1. Obtaining the BEA WebLogic Adapter for PeopleSoft 8

Step 2. Configuring the Domain

Step 3. Extracting JARs and Adjusting the Classpath

Step 4. Updating the BEA License

Step 5. Deploying the Adapter Using the WebLogic Server Console

Step 6. Creating or Updating the Adapter Group

Next Steps
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1 Installing the Adapter for WebLogic Integration 7.0
Before Installing the Adapter

Before you install the BEA WebLogic Adapter for PeopleSoft 8, you must review the
BEA WebLogic Adapter for PeopleSoft 8 Release Notes to ensure that you have the
required prerequisite software installed. The BEA WebLogic Adapter for PeopleSoft
8 Release Notes is available at the following URL:

http://edocs.bea.com/wladapters/doc70/index.html

Understanding the Representation of Paths

Because the location of files in the WebLogic Integration environment depends on
options selected during installation and configuration, the conventions that follow are
used throughout to represent paths.

BEA_HOME represents the BEA Home directory specified for your WebLogic
installation.

For example, if you install the product in the default location on a Windows
system, BEA_HOME represents c:\bea.

WLI_HOME represents the root of your WebLogic Integration installation.

For example:

If you install WebLogic Integration 7.0 in the default location on a Windows
system, WLI_HOME represents c:\bea\weblogic700\integration.

domain is used to indicate the name of a domain.

In WebLogic Integration 7.0, a new tool, the Configuration Wizard, is used
to create custom user domains. When you use the Configuration Wizard to
set up the domain configuration stored on the administration server, you are
prompted to assign a domain name, domain, and to specify the location to
which the domain directory will be installed. The files required by the
administration server are installed in the domain directory under the
specified location.
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Step 1. Obtaining the BEA WebLogic Adapter for PeopleSoft 8
For additional information, see Using the Configuration Wizard which is
available at the following URL:

http://edocs.bea.com/platform/docs70/confgwiz/index.html

For example, if you accept the Configuration Wizard default location,
BEA_HOME\user_projects, the files required by the administration server
are installed in the following directory:

BEA_HOME\user_projects\domain

DOMAIN_HOME represents the complete path to the root of a domain.

For example:

If you use the WebLogic Integration 7.0 Configuration Wizard to create a
domain in the default location on a Windows system, DOMAIN_HOME
represents c:\bea\weblogic700\user_projects\domain.

Note: WLI_HOME and BEA_HOME (italicized) also represent the corresponding
Windows and UNIX environment variables. For example, the literal
interpretation of WLI_HOME is %WLI_HOME% for Windows and $WLI_HOME for
UNIX.

Unlike WLI_HOME and BEA_HOME, DOMAIN_HOME is not an environment
variable that is set by default in the WebLogic Integration environment.

Step 1. Obtaining the BEA WebLogic Adapter 
for PeopleSoft 8

The BEA WebLogic Adapter for PeopleSoft 8 software is packaged as an EAR file
(BEA_PEOPLESOFT_1_0_70.ear). You can obtain the software on CD or download it
from www.bea.com.
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1 Installing the Adapter for WebLogic Integration 7.0
Step 2. Configuring the Domain

The adapter can only be deployed in a domain that includes support for application
integration functionality. If you have not already done so, use the Configuration
Wizard to create the domain and select one of the following domain templates:

Enterprise application integration (EAI) domain template

WebLogic Integration (WLI) domain template

Platform domain template

For the information you need to configure a fully functional domain based on the
template, see the appropriate section of the Configuration Wizard Template Reference:

For the EAI domain template, see the following URL:

http://edocs.bea.com/platform/docs70/template/eaidomain.html

For the WLI domain template, see the following URL:

http://edocs.bea.com/platform/docs70/template/wlidomain.html

For the platform domain template, see the following URL:

http://edocs.bea.com/platform/docs70/template/platjar.html

For general information about using the Configuration Wizard, see Using the
Configuration Wizard at the following URL:

http://e-docs.bea.com/platform/docs70/confgwiz/index.html

When you use the Configuration Wizard to create a domain based on the WLI or EAI
domain template, a domain-specific version of the Database Wizard is installed in the
DOMAIN_HOME directory. You must run the Database Wizard for the domain to
initialize the database repository with the required tables and system data. For
additional information, see “Configuring the Database for a Domain” in Starting,
Stopping and Customizing BEA WebLogic Integration, at the following URL:

http://edocs.bea.com/wli/docs70/config/index.htm
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Step 3. Extracting JARs and Adjusting the Classpath
Step 3. Extracting JARs and Adjusting the 
Classpath

Set the classpath using the procedure appropriate for your system:

Extracting JARs and Adjusting the Classpath for Windows

Extracting JARs and Adjusting the Classpath for UNIX

Extracting JARs and Adjusting the Classpath for 
Windows

To extract the adapter JAR files and adjust the classpath on Windows:

1. Use WinZip (or another similar extracting product) to extract the
BEA_PEOPLESOFT_1_0_70.ear file to a directory of your choice (for example,
BEA_HOME\lib\PeopleSoft).

2. Copy the psjoa.jar from your PS_HOME Web directory to the directory into
which you extracted the BEA_PEOPLESOFT_1_0_70.ear file (for example,
BEA_HOME\lib\PeopleSoft).

The psjoa.jar file is the Java Object Adapter (JOA) shipped with your
PeopleSoft application. This file is required by both WebLogic Server and the
BEA Application Explorer. It can be found in your PS_HOME Web directory.

Note: The psjoa.jar file is release-specific. Each time you upgrade your
Peopletools release, you must obtain the current version of psjoa.jar,
shut down WebLogic Server, and replace the old psjoa.jar with the
current version.

3. If you are using PeopleSoft release 8.1x, copy the pstools.properties file
(which is also found in your PS_HOME Web directory) to the same directory as the
psjoa.jar file.

4. Go to the root directory for your domain:
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1 Installing the Adapter for WebLogic Integration 7.0
cd DOMAIN_HOME

Note: You must choose a WebLogic Integration domain that supports application
integration functionality.

5. Find the SetDomainTypeData.cmd file.

Here, DomainType is the type of the domain. For example, if your domain is
configured to support the development of solutions that employ the full range of
WebLogic Integration functionality, it contains the SetwliDomainData.cmd
file.

Note: In addition, you must also place the component interface API files in the
classpath before starting the WebLogic Integration server. For information on
compiling the PeopleSoft API Java programs, see the BEA WebLogic Adapter
for PeopleSoft® 8 User Guide.

6. Update the SVRCP environment variable settings in the
SetDomainTypeData.cmd file.

Note: The SVRCP environment variable is used in the SetDomainTypeData
script to set the classpath for the java executable.

After the following line:

set SVRCP=%SVRCP%;%WLI_DOMAIN_HOME%\applications\DefaultWebApp_
myserver\WEB-INF\classes

add the following lines:

REM Set PeopleSoft 8 Adapter classpath

SET SVRCP=%SVRCP%;BEA_HOME\lib\PeopleSoft\psjoa.jar

Add the jar file appropriate to your version of PeopleSoft. Use the following
line, replacing nn with the 81 for PeopleSoft 8.1x, or 84 for PeopleSoft 8.4x:

SET SVRCP=%SVRCP%;BEA_HOME\lib\PeopleSoft\PS_BEA_CInn.jar

If you are using PeopleSoft 8.1x, you must also add the location of the
pstools.properties file.

SET SVRCP=%SVRCP%;BEA_HOME\lib\PeopleSoft

Here, BEA_HOME\lib\PeopleSoft\ represents the directory specified in step1.
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Step 3. Extracting JARs and Adjusting the Classpath
Extracting JARs and Adjusting the Classpath for UNIX

To extract the adapter JAR files and adjust the classpath on UNIX:

1. Use jar (or another similar extracting product) to extract
BEA_PEOPLESOFT_1_0_70.ear to a directory of your choice (for example,
BEA_HOME/lib/PeopleSoft).

2. Copy the psjoa.jar from your PS_HOME Web directory to the directory into
which you extracted the BEA_PEOPLESOFT_1_0_70.ear file (for example,
BEA_HOME\lib\PeopleSoft).

The psjoa.jar file is the Java Object Adapter (JOA) shipped with your
PeopleSoft application. This file is required by both WebLogic Server and the
BEA Application Explorer. It can be found in your PS_HOME Web directory.

Note: The psjoa.jar file is release-specific. Each time you upgrade your
Peopletools release, you must obtain the current version of psjoa.jar,
shut down WebLogic Server, and replace the old psjoa.jar with the
current version.

3. If you are using PeopleSoft release 8.1x, copy the pstools.properties file
(which is also found in your PS_HOME Web directory) to the same directory as the
psjoa.jar file.

4. Go to the root directory for your domain:

cd DOMAIN_HOME

Note: You must choose a WebLogic Integration domain that supports application
integration functionality.

5. Find the SetDomainTypeData.cmd file.

Here, DomainType is the type of the domain. For example, if your domain is
configured to support the development of solutions that employ the full range of
WebLogic Integration functionality, it contains the SetwliDomainData.cmd
file.

Note: In addition, you must also place the component interface API files in the
classpath before starting the WebLogic Integration server. For information on
compiling the PeopleSoft API Java programs, see the BEA WebLogic Adapter
for PeopleSoft® 8 User Guide.
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1 Installing the Adapter for WebLogic Integration 7.0
6. Update the SVRCP environment variable settings in the
SetDomainTypeData.cmd file.

Note: The SVRCP environment variable is used in the SetDomainTypeData
script to set the classpath for the java executable.

After the following line:

set SVRCP=$SVRCP:$WLI_DOMAIN_HOME/applications/DefaultWebApp_my
server/WEB-INF/classes

add the following JAR files, which are listed in the order required for the
classpath:

# Set PeopleSoft 8 Adapter classpath

SET SVRCP=$SVRCP:BEA_HOME/lib/PeopleSoft/psjoa.jar

# For PS 8.1x, use PS_BEA_CI81.jar.
# For PS 8.4x, use PS_BEA_CI84.jar.

SET SVRCP=$SVRCP:BEA_HOME/lib/PeopleSoft/PS_BEA_CInn.jar

# For PS 8.1x, add the location of
# the pstools.properties file

SET SVRCP=$SVRCP:BEA_HOME\lib\PeopleSoft

Here, BEA_HOME/lib/PeopleSoft is the directory specified in step1.

Step 4. Updating the BEA License

The BEA WebLogic Adapter for PeopleSoft 8 cannot be used without a valid software
license. If you have downloaded the adapter for evaluation, you must obtain an
evaluation license as described on the adapter download page. If you have purchased
a license for the adapter, the license file is typically sent to you as an e-mail attachment.

To update your license.bea file:

1. Save the license file that you obtained with a name other than license.bea, in the
BEA_HOME directory. For example, save the file as
peoplesoft_adapter_license.bea. Use this file as the
license_update_file in step 4 of this procedure.

Warning: Do not overwrite or change the name of the existing license.bea file.
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Step 5. Deploying the Adapter Using the WebLogic Server Console
2. Perform the step appropriate for your platform:

On a Windows system, open an MS-DOS session and go to the BEA_HOME
directory.

On a UNIX system, go to the BEA_HOME directory.

3. If it is not already included, add the JDK to your PATH variable by executing the
command appropriate to your system:

On a Windows system:

set PATH=BEA_HOME\jdk131_03\bin;%PATH%

On a UNIX system:

PATH=BEA_HOME/jdk131_03/bin:$PATH
export PATH

4. Merge the license update file into your existing license by executing the
command appropriate to your system:

On a Windows system:

UpdateLicense license_update_file

On a UNIX system:

sh UpdateLicense.sh license_update_file

Here, license_update_file is the name to which you saved the license
update file in step 1.

5. Save a copy of your updated license.bea file in a safe place outside the
WebLogic Integration and application installation directories.

Step 5. Deploying the Adapter Using the 
WebLogic Server Console

After the BEA WebLogic Adapter for PeopleSoft 8 is installed, it must be deployed to
your domain.
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1 Installing the Adapter for WebLogic Integration 7.0
To deploy an adapter using the WebLogic Server Administration Console:

1. Start WebLogic Server.

2. Start the WebLogic Server Administration Console in a browser using the
following URL:

http://host:port/console/

Here, host represents the machine on which WebLogic Server is running and
port represents the listening port.

For example, http://localhost:7001/console/

3. When prompted, enter the user name and password for the server.

The WebLogic Server Administration Console opens.

Figure 1-1 WebLogic Server Console

4. In the left pane, choose Deployments and then Applications from the navigation
tree.

The console displays the Applications window.
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Step 5. Deploying the Adapter Using the WebLogic Server Console
Figure 1-2 Applications Window

5. Click the Configure a new Application link.

The console displays the Locate Application or Component to configure
window.

Figure 1-3 Locate Application or Component to Configure Window

6. Do one of the following:

If you copied the BEA_PEOPLESOFT_1_0_70.ear file to a directory on the
administrative server, navigate to that directory. For example, if you copied the
file to the D:\bea\AdapterEars directory, select the directory as shown in the
following figure.
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1 Installing the Adapter for WebLogic Integration 7.0
Figure 1-4 Locating the Adapter EAR File

If you have not copied the BEA_PEOPLESOFT_1_0_70.ear file to a directory on
the administrative server, do the following:

a. Navigate to the directory to which the file will be uploaded.

For example, to upload the adapter from your local machine to the
D:\bea\AdapterEars directory on the administrative server, select the
directory as shown in the following figure.

Figure 1-5 Selecting the Target Directory

b. Click the upload it through your browser link to display the Install or Update
an Application window.

c. Click Browse to display the Choose File dialog box.

d. In the Choose File dialog box, locate the file and then click Open.

The console displays the selected location.

Figure 1-6 Install or Update an Application Window
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Step 5. Deploying the Adapter Using the WebLogic Server Console
e. Click Upload.

The browser status bar indicates upload progress. When the upload is
complete, you are returned to the Locate Application or Component to
configure window. The uploaded file now resides in the directory selected in
step a.

Figure 1-7 Adapter EAR File Uploaded to Administrative Server

7. Click the [select] link to the left of the adapter EAR file.

The console displays the Configure Application or Component window.

Figure 1-8 Configure Application or Component Window

8. Select the servers or clusters on which to deploy the adapter by using the arrow
buttons to move entries from the available list to the target list.

9. You must change the application name from BEA_PEOPLESOFT_1_0_70 to
BEA_PEOPLESOFT_1_0.

Note: If you do not change the application name, the adapter will not be available
to application views.

The following figure shows a configured application.
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1 Installing the Adapter for WebLogic Integration 7.0
Figure 1-9 Configured Application

10. Click Configure and Deploy.

The console displays the deployment status, which includes a description, status,
begin time, and end time for the deployed adapter.

Step 6. Creating or Updating the Adapter 
Group

Before you create an application view that uses the events or services supported by an
adapter, the following requirements must be met:

The user group, adapter, must be defined.

The administrative server user name must be a member of the adapter group.

The action required to complete the configuration depends on which domain template
you selected when you created the domain. See the following table for guidelines.
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Step 6. Creating or Updating the Adapter Group
Creating the Adapter Group 

To create the adapter group and add the administrative server user name to it:

1. In the left pane of the WebLogic Server Administration Console, choose
Compatibility Security and then Groups from the navigation tree.

2. Click the Create a New Group link to display the Group window.

Figure 1-10 Group Window

3. Enter adapter in the Name field.

Table 1-1 Configuration Requirements

If you created a
domain based on
the . . .

Andthe administrative
server user name is . . .

Then . . .

Platform domain
template

Any value Create the adapter group and add the
administrative user name to it as
described in “Creating the Adapter
Group” on page 1-15.

WLI or EAI domain
template

system The adapter group is already
defined. This group includes the
system user name by default.

No further configuration is required.

WLI or EAI domain
template

A value other than system The adapter group is already
defined. Add the user name to the
group as described in “Adding the
User Name to the Adapter Group” on
page 1-16.
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1 Installing the Adapter for WebLogic Integration 7.0
4. Enter the administrative server user name in the Add Users field.

5. Click Apply.

The Group window is updated as shown in the following figure.

Figure 1-11 Group Window

Adding the User Name to the Adapter Group

To add the administrative server user name to the adapter group:

1. In the left pane of the WebLogic Server Administration Console, choose
Compatibility Security and then Groups from the navigation tree.

The console displays the groups currently defined for the domain.

2. Locate and click the link for the adapter group to display the group definition.

Figure 1-12 Group Definition

3. If the administrative server user name is not included in the Members list, enter
the user name in the Add Users field.
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Next Steps
4. Click Apply to add the user name to the group.

The name is added to the Members list.

Next Steps

If you have not already installed the BEA Application Explorer, install it now. See the
BEA Application Explorer Installation and Configuration Guide.

When you have successfully deployed the adapter and installed the BEA Application
Explorer, you can log on to the WebLogic Integration Application View Console to
create application views that employ events and services supported by the BEA
WebLogic Adapter for PeopleSoft 8. For more information, see the BEA WebLogic
Adapter for PeopleSoft 8 User Guide.
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CHAPTER
2 Installing and 
Compiling the 
Component Interfaces

This section describes how to install and compile the component interfaces. It includes
the following topic and installation steps:

BEA WebLogic Adapter for PeopleSoft 8 Component Interfaces

Step 1. Making Component Interfaces Available to PeopleSoft 8

Step 2. Configuring Component Interface Security

Step 3. Testing the Component Interfaces

Step 4. Modifying the Classpath of the Machine that Runs BEA Application
Explorer

Note: For more information about the BEA Application Explorer, see the BEA
Application Explorer User Guide.
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2 Installing and Compiling the Component Interfaces
BEA WebLogic Adapter for PeopleSoft 8 
Component Interfaces

BEA delivers two component interfaces as part of the BEA WebLogic Adapter for
PeopleSoft 8. These component interfaces are used in conjunction with the BEA
Application Explorer to facilitate the creation of schemas for events and services. The
BEA Application Explorer uses the delivered components for metadata information to
build schemas.

For the delivered component interfaces, you must perform the following steps:

1. Make the delivered component interfaces available to PeopleSoft 8.

2. Configure the component interface security.

3. Test the component interfaces.

4. Modify the classpath of the machine that runs BEA Application Explorer.

Step 1. Making Component Interfaces 
Available to PeopleSoft 8

The supplied component interfaces are delivered via a PeopleSoft project. For
PeopleSoft release 8.1x, the project is called BEA_CI_81 and is contained within file,
BEA_CI_81.zip. For PeopleSoft release 8.4x, the project and file name are
BEA_CI_84 and BEA_CI_84.zip, respectively. The zip files are located within the
BEA_PEOPLESOFT_1_0.ear file. You can extract it using any extraction software.
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Step 1. Making Component Interfaces Available to PeopleSoft 8
Importing Project BEA_CI_81 or BEA_CI_84 to 
PeopleSoft 8

To import the BEA_CI_81 or BEA_CI_84 project to PeopleSoft 8:

1. Unzip the BEA_CI_81.zip or BEA_CI_84.zip file to a directory of your choice.

The unzip process will create its own subdirectory.

For example, if you extract it to c:\temp, a subdirectory called BEA_CI_81 or

BEA_CI_84 is created in c:\temp.

2. Launch the PeopleSoft 8 Application Designer in two-tier mode.

3. From the File menu, choose Copy Project from File.

Note: In PeopleSoft release 8.4 or higher, from the Tools menu, you must choose
Copy Project→From File.

4. Navigate to the original directory to which you unzipped the file.

Figure 2-1 Application Designer Window - Release 8.1
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2 Installing and Compiling the Component Interfaces
Figure 2-2 Application Designer Window - Release 8.4

The Application Designer displays the Copy Project From File dialog box.

Figure 2-3 Copy Project From File Dialog Box - Release 8.1

Figure 2-4 Copy From File: Select Project Dialog Box - Release 8.4

5. Click Copy (in release 8.1) or Open (in release 8.4) to open the Copy dialog box.
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Step 1. Making Component Interfaces Available to PeopleSoft 8
Note: Although the following figures illustrate PeopleSoft release 8.4, the
corresponding steps are accurate for releases 8.1 and 8.4.

Figure 2-5 Application Designer - Copy From File Dialog Box

6. Make sure that all the objects listed under Object Types are highlighted and click
Copy. The Application Designer displays a copy ended message to indicate
successful completion.

Figure 2-6 Application Designer - Copy Ended Message

7. Build the views in the project by choosing Build→Project.

The Build dialog box opens.
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Figure 2-7 Application Designer - Build Dialog Box

8. Select Create Views in Build Options. Select your site’s customary option in
Build Execute Options. (In the previous figure, we have selected Execute SQL
now.)

9. Click Build.

The Application Designer displays a Build Progress status window.

Figure 2-8 Application Designer - Build Progress Dialog Box

Notice that there are zero errors and zero warnings.

You may use your native SQL Tool to view the records from the generated view
to ensure that they have been created correctly.

10. If the view has not been generated correctly, click Close and double-click the
SQL Build log statement.

The PSBUILD log file displays.
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Step 1. Making Component Interfaces Available to PeopleSoft 8
Figure 2-9 Application Designer - PSBUILD Process Log File

11. If you encounter problems, check the Build settings options by choosing
Build→Settings.

Figure 2-10 Application Designer - Build Settings Dialog Box

Depending on the application server database for PeopleSoft 8, some databases
may require the Tablespace name. Consult your PeopleSoft 8 database
administrator for more information regarding this function.
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Step 2. Configuring Component Interface 
Security

Before the delivered component interfaces can be used, security for each component
interface must be set. Component interface security should be set for each distinct
Permission List belonging to users who are going to use the product being installed.

You must set the security for all delivered component interfaces in the project. In
PeopleSoft release 8.1, you may set security in 2, 3, or 4-tier mode; in release 8.4 and
higher, you may set security 4-tier mode. Regardless of your release level or interface,
you must follow the same steps.

To configure component interface security for PeopleSoft release 8.4 in 4-tier mode:

1. ChoosePeopleTools→Security→UserProfiles→Permissions&Roles→Permission
Lists.

Figure 2-11 Permission Lists Window

2. Click Search and select the relevant Permission List.
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Step 2. Configuring Component Interface Security
Figure 2-12 Searching for Permission Lists

3. Click the right arrow next to the Sign-on Times tab to display the Component
Interfaces tab.

Figure 2-13 Finding the Component Interfaces tab

4. Click the Component Interfaces tab.
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Figure 2-14 Component Interfaces Window

5. Click the + button to add a new row to the Component Interfaces list.

Figure 2-15 Component Interfaces List

6. Enter or select the BEA_CI_ATTRIBUTES component interface and click Edit.

Figure 2-16 Component Interface Permissions Window
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Step 3. Testing the Component Interfaces
7. Click Full Access (All) to set the Get and Find methods to Full Access.

8. Click OK.

9. Repeat steps 5 through 8 for the BEA_CI_MESSAGES component interface.

10. Scroll down to the bottom of the Component Interfaces window and click Save.

Step 3. Testing the Component Interfaces

All BEA delivered component interfaces must be tested individually before continu-
ing. Using Application Designer, open each component interface individually and test
the component interfaces BEA_CI_ATTRIBUTES and BEA_CI_MESSAGES by executing
the Find and Get methods.

1. Open the BEA_CI_ATTRIBUTES Component Interface.

2. Choose Tools→Test Component Interface.

The Component Interface Tester dialog box opens.

Figure 2-17 Component Interface Tester Dialog Box

Note that the Create New option is disabled. This is because the Add method is
not applicable to this component interface.

3. Click the Find button. Entries for the underlying component are displayed.

A message may appear stating that display is limited to a certain number of
entries; this is not a problem.
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2 Installing and Compiling the Component Interfaces
Figure 2-18 Component Interface Tester - Find Results Window

4. Highlight one of the lines with its corresponding key in the Find Results window
and click the Get Selected button.

The relevant data for the selected key is displayed.

Figure 2-19 Component Interface Tester Window

If this window is displayed, the component interface has been successfully tested
for the Find method.

5. Click the Get button. For the Get method, an existing key must be entered.

Figure 2-20 Component Interface Tester Window

The exposed properties for the key that is entered are returned.
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Step 4. Modifying the Classpath of the Machine that Runs BEA Application Explorer
Figure 2-21 Component Interface Tester - Results Window

If this window is displayed, the component interface has been successfully tested
for the Get method.

6. Repeat this process for each of the delivered component interfaces.

Step 4. Modifying the Classpath of the 
Machine that Runs BEA Application Explorer

The BEA Application Explorer requires the same set of jar files as required by the
WebLogic Integration Server. These are the jar files that were extracted in Step 3.
Extracting JARs and Adjusting the Classpath in Chapter 1, “Installing the Adapter for
WebLogic Integration 7.0,” and put in the classpath in the SetDomainTypeData.cmd
file.

However, unlike the WebLogic Integration Server, no changes in command files are
required. It is sufficient to simply place these files in the lib directory of the BEA
Application Explorer. These files include the PeopleSoft Java Object Adapter file
(psjoa.jar) and pstools.properties (for release 8.1)

The psjoa.jar and the pstools.properties change with each release. For information
on replacing these files, see the warning at the end of the section called Step 3.
Extracting JARs and Adjusting the Classpath in Chapter 1, “Installing the Adapter for
WebLogic Integration 7.0.”
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CHAPTER
3 Installing and 
Configuring the BEA 
TCP/IP Message Router

To enable PeopleSoft 8 to send an XML event document to the WebLogic
environment using TC/PIP, you must load the required software on the PeopleSoft 8
system and configure the PeopleSoft 8 application gateway. This section describes
how to do so, and includes the following topics:

Installing BEA TCP/IP Handler for PeopleSoft Release 8.1

Installing BEA TCP/IP Target Connector for PeopleSoft Release 8.4 and Higher

Installing BEA TCP/IP Handler for 
PeopleSoft Release 8.1

This topic provides instructions for installing the BEA TCP/IP Handler for PeopleSoft
release 8.1.

Note: To install and configure the BEA TCP/IP Handler on PeopleSoft Version 8.1x,
see “Step 1. Extracting and Installing the BEA TCP/IP Handler,” and “Step 2.
Configuring the BEA TCP/IP Handler on the PeopleSoft 8 Gateway Server.”
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3 Installing and Configuring the BEA TCP/IP Message Router
To install and configure the BEA TCP/IP Handler on PeopleSoft version 8.4
or higher, see “Installing BEA TCP/IP Target Connector for PeopleSoft
Release 8.4 and Higher.”

It includes the following steps:

Step 1. Extracting and Installing the BEA TCP/IP Handler

Step 2. Configuring the BEA TCP/IP Handler on the PeopleSoft 8 Gateway
Server

Step 1. Extracting and Installing the BEA TCP/IP Handler

The BEA TCP/IP Handler software for PeopleSoft release 8.1 is in the
TCPIPHandler81.jar file and is located within the BEA_PEOPLESOFT_1_0.ear
archive. To extract the .jar file from the .ear archive, use WinZip or a similar
extraction tool. Once extracted, you must port the file to the platform where the
PeopleSoft 8 gateway Web server is located, place it in the servletclasses directory
under the PeopleSoft Web server, and extract the embedded class files.

The following example illustrates an installation on a UNIX SUN/Solaris machine
where the PeopleSoft 8 application server is running:

1. Log on to the UNIX machine with the proper PeopleSoft 8 ID and permissions.

2. Navigate to the PeopleSoft 8 Web servlets directory. This may vary between
releases and may change according to you r Web Server, but typically it is:

$PS_HOME/webserv/servletclasses

3. Issue the jar command to extract the class files required by PeopleSoft.

This is a sample command:

jar -xvf /tmp/TCPIPHandler81.jar

The following output would be displayed:

$ jar -xvf /tmp/TCPIPHandler81.jar
created: META-INF/

extracted: META-INF/MANIFEST.MF
extracted: psft/pt8/tcphandler/TCPIPHandler81$Entry.class
extracted:
psft/pt8/tcphandler/TCPIPHandler81$HandlerEntry.class
extracted:
3-2 BEA WebLogic Adapter for PeopleSoft 8 Installation and Configuration Guide



Installing BEA TCP/IP Handler for PeopleSoft Release 8.1
psft/pt8/tcphandler/TCPIPHandler81$PublicationHandler.class
extracted: psft/pt8/tcphandler/TCPIPHandler81.class
$

Notice that the files are placed in a new directory, tcphandler, under the
psft/pt8 directory structure.

Step 2. Configuring the BEA TCP/IP Handler on the 
PeopleSoft 8 Gateway Server

To configure the BEA TCP/IP Handler:

1. Launch the PeopleSoft 8 configuration servlet interface (server gateway). This is
typically under:

http://serverURL/servlets/gateway.administration

Figure 3-1 PeopleSoft 8.16.03 Handler Directory Window

2. Click the Add handler button.

The Add Handler window opens.

Figure 3-2 Add Handler Window

3. In the Handler class field, enter the name of the BEA PeopleSoft 8 handler class:

psft.pt8.tcphandler.TCPIPHandler81

4. Click Save. The Handler displays the following status window:
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3 Installing and Configuring the BEA TCP/IP Message Router
Figure 3-3 Handler Status Window

The handler appears in the Handler directory list, but the Status reads Not
loaded.

5. Click Load to activate that handler. Once loaded, the gateway servlet loads the
specified Java class in memory after searching the machine Classpath.

The Status column should read Loaded successfully. If you receive a
ClassNotFoundException error as the status, the gateway servlet did not find the
particular Java class you indicated. Make sure that the Classpath is correct. If
necessary, you may need to restart your Web server.

During production, you may want to temporarily deactivate a handler. To
deactivate a handler, click the Unload button. This removes the particular
handler from the list of active registered handlers to which the gateway servlet
can publish messages.

If the .jar file was placed in the correct PeopleSoft 8 application directory on the
correct application server, the following screen opens:

Figure 3-4 Load Handler Window

6. Click the Configure button to switch to the lookup table view.

Figure 3-5 TCPIP81 Handler Directory Window

7. Click the Add a TCPIP81 node button.

The TCPIP81 Handler window opens.
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Installing BEA TCP/IP Target Connector for PeopleSoft Release 8.4 and Higher
8. In the Node Name field, enter the name of the node you want to add, such as
BEA_MSGNODE.

9. In the Host Name field, enter the name of the host machine of the WebLogic
Integration server.

10. In the Port field, enter the TCP port that was entered during the adding of the
application view event.

11. In the Trace Directory field, enter the directory where the trace file should be
created in case the handler experiences some problem with the message delivery.

Figure 3-6 Add TCPIP81 Handler Window

12. Click Save. The BEA Handler Directory window opens.

Figure 3-7 TCPIP81 Handler Directory Window With Node

The BEA TCP/IP Handler configuration is now complete.

Installing BEA TCP/IP Target Connector for 
PeopleSoft Release 8.4 and Higher

The BEA TCP/IP Target Connector software for PeopleSoft release 8.4 is in the
TCPIPTARGET84.class file and is located within the BEA_PEOPLESOFT_1_0.ear
archive. To extract the .class file from the .ear archive, use WinZip or a similar
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3 Installing and Configuring the BEA TCP/IP Message Router
extraction program. Once extracted, you must port the file to the platform where the
PeopleSoft 8 gateway Web server is located and place it in the PS server target
connector directory. This will be located in different places depending on your web
server. Typically, these will be:

For WebLogic,

c:\bea\wlserver6.1\config\peoplesoft\applications\PSIGW\Web-inf
\classes\com\peoplesoft\pt\integrationgateway\targetconnector

For WebSphere,

c:\websphere\AppServer\installedApps\peoplesoft\PSIGW\Web-inf\
classes\com\peoplesoft\pt\integrationgateway\targetconnector

Creating a Gateway

To create a gateway:

1. Click PeopleTools → Integration Broker → Gateways.

Figure 3-8 Gateways Window

2. Find the Local Gateway and enter the URL in the Gateway URL field.

This URL is usually set during installation.
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Installing BEA TCP/IP Target Connector for PeopleSoft Release 8.4 and Higher
Figure 3-9 Gateway URL Window

3. Click the Load button. The Connector Properties are displayed. These are
predefined during the Integration Broker installation.

Figure 3-10 Connector Properties Window

4. Click OK. The TCPIPTARGET84 connector is included in the Connectors list.

5. Enter the Gateway URL. The following window opens.

Figure 3-11 PeopleSoft Integration Gateway Window

The Gateway is now configured.
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